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About this manual 
 

This manual describes the System 200V CPU 21x-2BM06 from VIPA. Here 
you may find every information for commissioning and operation. 
 

Chapter 1: Basics and Assembly 
The focus of this chapter is on the introduction of the VIPA System 200V. 
Here you will find the information required to assemble and wire a controller 
system consisting of System 200V components. 
Besides the dimensions the general technical data of System 200V will be 
found.   
 
Chapter 2: Hardware description 
Here the hardware components of the CPU are described. The technical 
data are at the end of the chapter. 
 
Chapter 3: Deployment CPU 21x-2BM06 
This chapter describes the deployment of the CPU in the System 200V. 
The description refers directly to the CPU and to the deployment in 
connection with peripheral modules, mounted on a profile rail together with 
the CPU at the backplane bus. 
 
Chapter 4: PROFIBUS communication 
Content of this chapter is the deployment of the 21x-2BM06 with 
PROFIBUS. After a short introduction into the PROFIBUS system, the 
project engineering and the usage with PROFIBUS is shown.  
This chapter ends with information about commissioning and start-up 
behavior of the DP master. 
 
Chapter 5: Configuration with TIA Portal 
In this chapter the project engineering of the VIPA CPU in the Siemens TIA 
Portal is shown. The chapter only describes the basic usage of the 
Siemens TIA Portal together with a VIPA CPU.  
More detailed information about the Siemens TIA Portal is to be found in 
the according online manual respectively documentation. 

Overview 
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This manual describes the System 200V CPU 21x-2BM06 from VIPA.  
It contains a description of the construction, project implementation and 
usage. 
This manual is part of the documentation package with order number  
HB97E_CPU and relevant for:  
Product Order number as of state: 
  CPU-HW CPU-FW DPM-FW 
CPU 21xDPM VIPA CPU 21x-2BM06 01 V 419 V 528 
 

The manual is targeted at users who have a background in automation 
technology. 
 

The manual consists of chapters. Every chapter provides a self-contained 
description of a specific topic. 
 

The following guides are available in the manual: 
• an overall table of contents at the beginning of the manual 
• an overview of the topics for every chapter 
 

The manual is available in: 
• printed form, on paper 
• in electronic form as PDF-file (Adobe Acrobat Reader) 
 

Important passages in the text are highlighted by following icons and 
headings: 
 

Danger! 
Immediate or likely danger. 
Personal injury is possible. 
 

Attention! 
Damages to property is likely if these warnings are not heeded. 
 

Note! 
Supplementary information and useful tips. 
 

 

Objective and 
contents 

Target audience 

Structure of the 
manual 

Guide to the 
document 

Availability 

Icons 
Headings 
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Safety information 
 

The CPU 21x is constructed and produced for: 
• all VIPA System 200V components 
• communication and process control 
• general control and automation applications 
• industrial applications 
• operation within the environmental conditions specified in the technical 

data 
• installation into a cubicle 
 

Danger! 
This device is not certified for applications in 
• in explosive environments (EX-zone) 
 

The manual must be available to all personnel in the 
• project design department 
• installation department 
• commissioning 
• operation 
 

The following conditions must be met before using or commissioning 
the components described in this manual: 
 
• Hardware modifications to the process control system should only be 

carried out when the system has been disconnected from power! 
 
• Installation and hardware modifications only by properly trained 

personnel. 
 
• The national rules and regulations of the respective country must be 

satisfied (installation, safety, EMC ...) 
 

National rules and regulations apply to the disposal of the unit! 
 

Applications 
conforming with 
specifications 

 

Documentation 

 

Disposal 
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Chapter 1 Basics and Assembly 
 

The focus of this chapter is on the introduction of the VIPA System 200V. 
Here you will find the information required to assemble and wire a controller 
system consisting of System 200V components. 
Besides the dimensions the general technical data of System 200V will be 
found.   
 

 

Topic     Page 
Chapter 1 Basics and Assembly ..................................................... 1-1 

Safety Information for Users................................................................. 1-2 
System conception ............................................................................... 1-3 
Dimensions .......................................................................................... 1-5 
Installation............................................................................................ 1-7 
Demounting and module exchange .................................................... 1-11 
Wiring................................................................................................. 1-12 
Installation guidelines ......................................................................... 1-14 
General data ...................................................................................... 1-17 

 

 

Overview 

Contents 
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Safety Information for Users 
 

VIPA modules make use of highly integrated components in MOS-
Technology. These components are extremely sensitive to over-voltages 
that can occur during electrostatic discharges. 
The following symbol is attached to modules that can be destroyed by 
electrostatic discharges. 
 

 
 
The Symbol is located on the module, the module rack or on packing 
material and it indicates the presence of electrostatic sensitive equipment. 
It is possible that electrostatic sensitive equipment is destroyed by energies 
and voltages that are far less than the human threshold of perception. 
These voltages can occur where persons do not discharge themselves 
before handling electrostatic sensitive modules and they can damage 
components thereby, causing the module to become inoperable or 
unusable. 
Modules that have been damaged by electrostatic discharges can fail after 
a temperature change, mechanical shock or changes in the electrical load. 
Only the consequent implementation of protection devices and meticulous 
attention to the applicable rules and regulations for handling the respective 
equipment can prevent failures of electrostatic sensitive modules. 
 

Modules must be shipped in the original packing material. 
 

 
When you are conducting measurements on electrostatic sensitive modules 
you should take the following precautions: 
• Floating instruments must be discharged before use. 
• Instruments must be grounded. 
Modifying electrostatic sensitive modules you should only use soldering 
irons with grounded tips. 
 

Attention! 
Personnel and instruments should be grounded when working on 
electrostatic sensitive modules. 
 
 

Handling of 
electrostatic 
sensitive modules 

Shipping of 
electrostatic 
sensitive modules 

Measurements and 
alterations on 
electrostatic 
sensitive modules 
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System conception 
 

The System 200V is a modular automation system for assembly on a 
35mm profile rail. By means of the peripheral modules with 4, 8 and 16 
channels this system may properly be adapted matching to your 
automation tasks. 
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The System 200V consists of the following components: 
• Head modules like CPU and bus coupler 
• Periphery modules like I/O, function und communication modules 
• Power supplies  
• Extension modules 
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With a head module CPU respectively bus 
interface and DC 24V power supply are 
integrated to one casing. 
Via the integrated power supply the CPU 
respectively bus interface is power 
supplied as well as the electronic of the 
connected periphery modules. 
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The modules are direct installed on a 
35mm profile rail and connected to the 
head module by a bus connector, which 
was mounted on the profile rail before. 
Most of the periphery modules are 
equipped with a 10pin respectively 18pin 
connector. This connector provides the 
electrical interface for the signaling and 
supplies lines of the modules. 
 

Overview 

Components 

Head modules 

Periphery modules 
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With the System 200V the DC 24V power 
supply can take place either externally or 
via a particularly for this developed power 
supply. 
The power supply may be mounted on the 
profile rail together with the System 200V 
modules. It has no connector to the back-
plane bus. 
 

 

CM 201
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3 4
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The expansion modules are complemen-
tary modules providing 2- or 3wire con-
nection facilities.  
The modules are not connected to the 
backplane bus. 
 

 

• Profile rail 35mm  
• Dimensions of the basic enclosure: 
 1tier width: (HxWxD) in mm: 76x25.4x74 in inches: 3x1x3 
 2tier width: (HxWxD) in mm: 76x50.8x74 in inches: 3x2x3 
 

Please note that you can only install header modules, like the CPU, the PC 
and couplers at slot 1 or 1 and 2 (for double width modules). 
 

[1] Head module 
(double width) 

[2] Head module  
(single width)  

[3] Periphery module 
[4] Guide rails 

1 2

4

3

0 1

Clack

D
P

 

 
Note 
A maximum of 32 modules can 
be connected at the back plane 
bus. Take attention that here the 
maximum sum current of 3.5A
is not exceeded. 
Please install modules with a 
high current consumption direct-
ly beside the header module.  
 

 

Power supplies 

Expansion 
modules 

Structure/ 
dimensions 

Installation 
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Dimensions 
 

1tier width (HxWxD) in mm: 76 x 25.4 x 74 
2tier width (HxWxD) in mm: 76 x 50.8 x 74 
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Dimensions 
Basic enclosure 

Installation 
dimensions 

Installed and wired 
dimensions 
In- / Output 
modules 



Chapter 1   Basics and Assembly Manual VIPA System 200V 

1-6  HB97E - CPU - RE_21x-2BM06 - Rev. 13/21 

                           

84,46 mm

88 mm

4,66 mm

27
 m

m

8 
cm

76
 m

m

24
 m

m

11 mm

85 mm

89 mm

 

89 mm

27
 m

m

8 
cm

76
 m

m

12 cm125 mm

91 mm

65
 m

m

24
 m

m

5 mm11 mm

85 mm

 
 

Function modules/ 
Extension modules 

CPUs (here with 
EasyConn from 
VIPA) 
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Installation 
 

The modules are each installed on a 35mm profile rail and connected via a 
bus connector. Before installing the module the bus connector is to be 
placed on the profile rail before. 
 

For installation the following 35mm profile rails may be used: 
 

35 mm

27 mm
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m
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m
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Order number Label Description 
290-1AF00 35mm profile rail Length 2000mm, height 15mm
290-1AF30 35mm profile rail Length 530mm, height 15mm 
 

System 200V modules communicate via a backplane bus connector. The 
backplane bus connector is isolated and available from VIPA in of 1-, 2-, 4- 
or 8tier width. 
The following figure shows a 1tier connector and a 4tier connector bus: 
 

 
 
The bus connector is to be placed on the profile rail until it clips in its place 
and the bus connections look out from the profile rail. 
Order number Label Description 
290-0AA10 Bus connector 1tier 
290-0AA20 Bus connector 2tier 
290-0AA40 Bus connector 4tier 
290-0AA80 Bus connector 8tier 

                           
 

General 

Profile rail 

Bus connector 
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The following figure shows the installation of a 4tier width bus connector in 
a profile rail and the slots for the modules.  
The different slots are defined by guide rails.  
 

[1] Header module  
(double width) 

[2] Header module  
(single width) 

[3] Peripheral module 
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[4] Guide rails 

       

• Use bus connectors as long as possible. 
• Sort the modules with a high current consumption right beside the 

header module. In the service area of www.vipa.com a list of current 
consumption of every System 200V module can be found. 

 

Installation on a 
profile rail  

Assembly regarding 
the current 
consumption 
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hoizontal assembly

lying assembly

vertical
assembly

0 1

0
1

Please regard the allowed environmental temperatures: 

• horizontal assembly: from 0 to 60°C 
• vertical assembly: from 0 to 40°C 
• lying assembly: from 0 to 40°C 
 
The horizontal assembly always starts at the left side with 
a header module, then you install the peripheral modules 
beside to the right.  
You may install up to 32 peripheral modules.  
 
 
 

80
 m

m
60

 m
m

 

Please follow these rules during the assembly! 
• Turn off the power supply before you install or remove 

any modules!  
• Make sure that a clearance of at least 60mm exists 

above and 80mm below the middle of the profile rail. 
 

• Every row must be completed from left to right and it 
has to start with a header module. 

 
[1] Header module (double width) 
[2] Header module (single width) 

1 2

4

3

 [3] Peripheral modules 
 [4] Guide rails 

 
 • Modules are to be installed side by side. Gaps are not 

permitted between the modules since this would 
interrupt the backplane bus. 

• A module is only installed properly and connected 
electrically when it has clicked into place with an 
audible click. 

• Slots after the last module may remain unoccupied.  
 

 
Note! 
A maximum of 32 modules can be connected at the back plane bus. Take 
attention that here the maximum sum current of 3.5A is not exceeded.  

Assembly 
possibilities 
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• Install the profile rail. Make sure that a clearance of at least 60mm 
exists above and 80mm below the middle of the profile rail. 

 
 
 
 
 
 
• Press the bus connector into the profile rail until it clips securely into 

place and the bus-connectors look out from the profile rail. This 
provides the basis for the installation of your modules. 

 
 
 
 
• Start at the outer left location with the installation of your header 

module and install the peripheral modules to the right of this. 
[1] Header module  

(double width) 
[2] Header module 

(single width) 
[3] Peripheral module 

1 2

4

3

[4] Guide rails 

• Insert the module that you are installing into the profile rail at an angle 
of 45 degrees from the top and rotate the module into place until it 
clicks into the profile rail with an audible click. The proper connection 
to the backplane bus can only be guaranteed when the module has 
properly clicked into place. 

Clack  

 

Attention! 
Power must be turned off before modules are 
installed or removed! 
 

 

Assembly 
procedure 
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Demounting and module exchange 
 

1

2

3

4

5

 
 
 

 
 

• Remove if exists the wiring to the module, by pressing both 
locking lever on the connector and pulling the connector. 

 
   
 
 
• The casing of the module has a spring loaded clip at the 

bottom by which the module can be removed. 
 
 
 

 
 
• The clip is unlocked by pressing the screwdriver in an upward 

direction. 
 
 
 
 
 
• Withdraw the module with a slight rotation to the top. 
 
 
 
 
 
 
 
 
 
 
 
 
Attention! 
Power must be turned off before modules are installed or 
removed! 
Please regard that the backplane bus is interrupted at the point 
where the module was removed! 
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Wiring 
 

Most peripheral modules are equipped with a 10pole or a 18pole connector. 
This connector provides the electrical interface for the signaling and supply 
lines of the modules. 
The modules carry spring-clip connectors for interconnections and wiring. 
The spring-clip connector technology simplifies the wiring requirements for 
signaling and power cables.  
In contrast to screw terminal connections, spring-clip wiring is vibration 
proof. The assignment of the terminals is contained in the description of the 
respective modules. 
You may connect conductors with a diameter from 0.08mm2 up to 2.5mm2 
(max. 1.5mm2 for 18pole connectors). 
The following figure shows a module with a 10pole connector. 
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[1] 
[2] 
[3] 
[4] 
[5] 

Locking lever 
Pin no. at the module 
Pin no. at the connector 
Wiring port 
Opening for screwdriver 
 

 

Note! 
The spring-clip is destroyed if you push the screwdriver into the wire port!  
Make sure that you only insert the screwdriver into the square hole of the 
connector! 
 

Overview 

     



Manual VIPA System 200V Chapter 1   Basics and Assembly 

HB97E - CPU - RE_21x-2BM06 - Rev. 13/21  1-13 

 
 

 
 

• Install the connector on the module until it locks with an audible click. 
For this purpose you press the two clips together as shown. 
The connector is now in a permanent position and can easily be wired. 

 
 
The following section shows the wiring procedure from top view. 
 

 

• Insert a screwdriver at an angel into the square opening as shown. 
• Press and hold the screwdriver in the opposite direction to open the 

contact spring. 
 
 
 
 
 
• Insert the stripped end of the wire into the round opening. You can use 

wires with a diameter of 0.08mm2 to 2.5mm2  
(1.5mm2 for 18pole connectors). 

 
 
 
 
 
 
 
• By removing the screwdriver the wire is connected safely with the plug 

connector via a spring. 
 

 

Note! 
Wire the power supply connections first followed by the signal cables 
(inputs and outputs). 
 
 

Wiring procedure 
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Installation guidelines 
 

The installation guidelines contain information about the interference free 
deployment of System 200V systems. There is the description of the ways, 
interference may occur in your control, how you can make sure the 
electromagnetic digestibility (EMC), and how you manage the isolation. 
 

Electromagnetic digestibility (EMC) means the ability of an electrical device, 
to function error free in an electromagnetic environment without being 
interferenced res. without interferencing the environment. 
All System 200V components are developed for the deployment in hard 
industrial environments and fulfill high demands on the EMC. Nevertheless 
you should project an EMC planning before installing the components and 
take conceivable interference causes into account. 
 

Electromagnetic interferences may interfere your control via different ways: 
• Electromagnetic fields (RF coupling) 
• Magnetic fields with power frequency 
• I/O signal conductors 
• Bus system 
• Current supply 
• Protected earth conductor 
 
Depending on the spreading medium (lead bound or lead free) and the 
distance to the interference cause, interferences to your control occur by 
means of different coupling mechanisms. 
One differs: 
• galvanic coupling 
• capacitive coupling 
• inductive coupling 
• radiant coupling 

 
 

General 

What means EMC? 

Possible 
interference 
causes 
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In the most times it is enough to take care of some elementary rules to 
guarantee the EMC. Please regard the following basic rules when installing 
your PLC. 
• Take care of a correct area-wide grounding of the inactive metal parts 

when installing your components. 
- Install a central connection between the ground and the protected 

earth conductor system. 
- Connect all inactive metal extensive and impedance-low. 
- Please try not to use aluminum parts. Aluminum is easily oxidizing 

and is therefore less suitable for grounding. 
• When cabling, take care of the correct line routing. 

- Organize your cabling in line groups (high voltage, current supply, 
signal and data lines). 

- Always lay your high voltage lines and signal res. data lines in 
separate channels or bundles. 

- Route the signal and data lines as near as possible beside ground 
areas (e.g. suspension bars, metal rails, tin cabinet). 

• Proof the correct fixing of the lead isolation. 
- Data lines must be laid isolated (for details see below). 
- Analog lines must be laid isolated. When transmitting signals with 

small amplitudes the one sided laying of the isolation may be 
favorable. 

- Lay the line isolation extensively on an isolation/protected earth con-
ductor rail directly after the cabinet entry and fix the isolation with 
cable clamps. 

- Make sure that the isolation/protected earth conductor rail is 
connected impedance-low with the cabinet. 

- Use metallic or metalized plug cases for isolated data lines. 
• In special use cases you should appoint special EMC actions. 

- Wire all inductivities with erase links, which are not addressed by the 
System SLIO modules. 

- For lightening cabinets you should avoid luminescent lamps. 
• Create a homogeneous reference potential and ground all electrical 

operating supplies when possible. 
- Please take care for the targeted employment of the grounding 

actions. The grounding of the PLC is a protection and functionality 
activity. 

- Connect installation parts and cabinets with the System SLIO in star 
topology with the isolation/protected earth conductor system. So you 
avoid ground loops. 

- If potential differences between installation parts and cabinets occur, 
lay sufficiently dimensioned potential compensation lines. 

Basic rules for 
EMC 
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Electrical, magnetically and electromagnetic interference fields are 
weakened by means of an isolation, one talks of absorption. 
Via the isolation rail, that is connected conductive with the rack, 
interference currents are shunt via cable isolation to the ground. Hereby 
you have to make sure, that the connection to the protected earth conduc-
tor is impedance-low, because otherwise the interference currents may 
appear as interference cause. 
 
When isolating cables you have to regard the following: 
• If possible, use only cables with isolation tangle. 
• The hiding power of the isolation should be higher than 80%. 
• Normally you should always lay the isolation of cables on both sides. 

Only by means of the both-sided connection of the isolation you achieve 
high quality interference suppression in the higher frequency area. 
Only as exception you may also lay the isolation one-sided. Then you 
only achieve the absorption of the lower frequencies. A one-sided 
isolation connection may be convenient, if: 
- the conduction of a potential compensating line is not possible 
- analog signals (some mV res. µA) are transferred 
- foil isolations (static isolations) are used. 

• With data lines always use metallic or metalized plugs for serial 
couplings. Fix the isolation of the data line at the plug rack. Do not lay 
the isolation on the PIN 1 of the plug bar! 

• At stationary operation it is convenient to strip the insulated cable 
interruption free and lay it on the isolation/protected earth conductor line. 

• To fix the isolation tangles use cable clamps out of metal. The clamps 
must clasp the isolation extensively and have well contact. 

• Lay the isolation on an isolation rail directly after the entry of the cable in 
the cabinet. Lead the isolation further on to the System 200V module 
and don't lay it on there again! 

 

Please regard at installation! 
At potential differences between the grounding points, there may be a 
compensation current via the isolation connected at both sides. 
Remedy: Potential compensation line. 
 

 
 

Isolation of 
conductors 
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General data 
 

• Profile rail 35mm  
• Peripheral modules with recessed labelling 
• Dimensions of the basic enclosure: 
 1tier width: (HxWxD) in mm: 76x25.4x74 in inches: 3x1x3 
 2tier width: (HxWxD) in mm: 76x50.8x74 in inches: 3x2x3 
 

• Wiring by means of spring pressure connections (CageClamps) at the 
front-facing connector, core cross-section 0.08 ... 2.5mm2 or 1.5 mm2 
(18pole plug) 

• Complete isolation of the wiring when modules are exchanged 
• Every module is isolated from the backplane bus 
• ESD/Burst acc. IEC 61000-4-2 / IEC 61000-4-4 (to level 3) 
• Shock resistance acc. IEC 60068-2-6 / IEC 60068-2-27 (1G/12G) 
• Class of protection IP20 
 

• Operating temperature: 0 ... +60°C 
• Storage temperature: -25 ... +70°C 
• Relative humidity: 5 ... 95% without condensation 
• Ventilation by means of a fan is not required 
 
 

Structure/ 
dimensions 

Reliability 

Environmental 
conditions 
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Chapter 2  Hardware description 
 

Here the hardware components of the CPU are described. The technical 
data are at the end of the chapter. 
 

 

Topic     Page 
Chapter 2 Hardware description...................................................... 2-1 

Properties............................................................................................. 2-2 
Structure .............................................................................................. 2-3 
Technical data...................................................................................... 2-7 
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Properties 
 

• Instruction set compatible with Siemens STEP 7 
• Configuration by means of the Siemens SIMATIC manager respectively 

TIA Portal 
• Integrated V-Bus controller for controlling System 200V peripherals 
• Integrated 24V power supply 
• Total address range: 1024Byte inputs, 1024Byte outputs 
 (128Byte process image each) 
• 96 / 128kByte of work memory "on board" 
• 144 / 192kByte of load memory "on board" 
• MMC slot (for user program) 
• Battery backed clock 
• MP2I interface for data transfer  
• Status LEDs for operating mode and diagnostics 
• Integrated PROFIBUS DP master 
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Type Order number Description 
CPU 214DPM VIPA 214-2BM06 SPS CPU 214 with PROFIBUS master 

and 96/144kByte of work/load memory 
 
 

CPU 21x-2BM06 

Order data 
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Structure 
 

[1] Operating mode switch 
[2] LEDs of the CPU 
[3] Slot for MMC  

memory card 
[4] MP2I interface 
[5] Slot for 24V DC  

power supply  
[6] LEDs of the PROFIBUS  

DP master  
[7] PROFIBUS DP interface 

Front view  
CPU 21xDPM 
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Please note that due to the system pin 2 of the PROFIBUS interface must 
not be connected! 
 
 
 
 

Interfaces 
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The CPU has an internal power supply. This is connected to an external 
supply voltage via two terminals located on the front of the unit.  
The power supply requires DC 24V (20.4 ... 28.8V). In addition to the 
electronic circuitry of the CPU this supply voltage is used for the modules 
connected to the backplane bus.  
The electronic circuitry of the CPU is not dc-insulated from the supply 
voltage. The power supply is protected against reverse polarity and short 
circuits. 
 

Note! 
Please ensure that the polarity of the supply voltage is correct. 
 

 

The MPI unit provides the link for the data transfer between the CPU and 
the PC. Via bus communication you are able to exchange programs and 
data between different CPUs that are linked over MPI. 
For a serial exchange between the partners you normally need a special 
MPI-converter. But now you are also able to use the VIPA "Green Cable" 
(Order-No. VIPA 950-0KB00), which allows you to establish a serial peer-
to-peer connection over the MPI interface.  
Please regard the "Hints for the deployment of the MPI interface" in chapter 
"Deployment CPU 21x". 
 

 

The CPU is connected to the PROFIBUS system by means of a 9pin jack.  
 

Note! 
More information about PROFIBUS can be found in the chapter 
"PROFIBUS communication". 
 
 

Power supply 

     

MP2I interface 

PROFIBUS 
interface 
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The CPUs have an integrated work and a load memory. The memories are 
battery-buffered. 
 
Order number Work memory Load memory 
VIPA 214-2BM06 96kByte 144kByte 

 
In the load memory there are program code and blocks stored together with 
the header information. 
The program parts and blocks, which are relevant for the running program, 
are loaded to the work memory during the program sequence. 
 

 

 
 
 

RN

ST

MR 

With the operating mode switch you may switch the CPU between STOP 
and RUN.  
During the transition from STOP to RUN the operating mode START-UP is 
driven by the CPU. 
By Switching to MR (Memory Reset) you request an overall reset  with 
following load from MMC, if a project there exists. 
 
 

 

 

You may install a VIPA MMC memory card in this slot as external storage 
device (Order No.: VIPA 953-0KX10). 
The access to the MMC takes always place after an overall reset. 
 

 

A rechargeable battery is installed on every CPU 21x to safeguard the 
contents of the RAM when power is removed. This battery is also used to 
buffer the internal clock. 
The rechargeable battery is maintained by a charging circuit that receives 
its power from the internal power supply and that maintain the clock and 
RAM for a max. period of 30 days.  
 

Attention! 
Due to a long storage of the CPU, the battery may be discharged 
excessively. Please connect the CPU at least for 24 hours to the power 
supply, to achieve the full buffer capacity. 
After a power reset and with an empty battery the CPU starts with a BAT 
error and executes an overall reset, because with an empty battery the 
RAM content is undefined. 
 

Memory 
management 

Operating mode 
switch 

MMC slot 
memory card 

Battery backup for 
clock and RAM 
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The CPU has got LEDs on its front side. In the following the usage and the 
according colors of the LEDs is described. 
 
Name Color Description 
PW green Indicates CPU power on. 
R green CPU status is RUN. 
S yellow CPU status is STOP. 

SF red Is turned on if a system error is detected  
(hardware defect) 

FC yellow Is turned on when variables are forced (fixed). 
MC yellow This LED blinks when the MMC is accessed.  

 

 

 

The LEDs are located in the left half of the front panel and they are used for 
diagnostic purposes.  
The following table shows the color and the significance of these LEDs. 
 

Name Color Description 
RN green DP-Master-RUN 

On: Master status is RUN. The slaves are being 
accessed and the outputs are 0 ("clear" state). 
On with DE: Master status is "operate". and is 
communicating with the slaves. 

IF red Initialization error 
On: Error in PROFIBUS configuration 

DE yellow DE (Data exchange) 
On: Indicates PROFIBUS communication activity. 

ER red Error 
On: Slave has failed 

 
 

LEDs CPU 

LEDs PROFIBUS 
DP master 



Manual VIPA System 200V Chapter 2   Hardware description 

HB97E - CPU - RE_21x-2BM06 - Rev. 13/21  2-7 

Technical data 
 

Order no. 214-2BM06 
Type CPU 214DPM 
Technical data power supply  
Power supply (rated value) DC 24 V 
Power supply (permitted range) DC 20.4...28.8 V 
Reverse polarity protection  
Current consumption (no-load operation) 130 mA 
Current consumption (rated value) 1.5 A 
Inrush current 65 A 
I²t 0.75 A²s 
Max. current drain at backplane bus 3 A 
Power loss 5 W 
Load and working memory  
Load memory, integrated 144 KB 
Load memory, maximum 144 KB 
Work memory, integrated 96 KB 
Work memory, maximal 96 KB 
Memory divided in 50% program / 50% data - 
Memory card slot MMC-Card with max. 512 

MB 
Hardware configuration  
Racks, max. 4  
Modules per rack, max. total max. 32 
Number of integrated DP master 1  
Number of DP master via CP 8  
Operable function modules 32  
Operable communication modules PtP 32  
Operable communication modules LAN - 
Status information, alarms, diagnostics  
Status display yes 
Interrupts no 
Process alarm no 
Diagnostic interrupt no 
Command processing times  
Bit instructions, min. 0.18 µs 
Word instruction, min. 0.78 µs 
Double integer arithmetic, min. 1.8 µs 
Floating-point arithmetic, min. 40 µs 
Timers/Counters and their retentive 
characteristics 

 

Number of S7 counters 256  
Number of S7 times 256  
Data range and retentive characteristic  
Number of flags 8192 Bit 
Number of data blocks 2047  
Max. data blocks size 16 KB 
Max. local data size per execution level 1024 Byte 
Blocks  
Number of OBs 14  
Number of FBs 1024  
Number of FCs 1024  
Maximum nesting depth per priority class 7  
Maximum nesting depth additional within an error 1  

214-2BM06 
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Order no. 214-2BM06 
OB 
Time  
Real-time clock buffered  
Clock buffered period (min.) 30 d 
Accuracy (max. deviation per day) 10 s 
Number of operating hours counter 8  
Clock synchronization - 
Synchronization via MPI - 
Synchronization via Ethernet (NTP) - 
Address areas (I/O)  
Input I/O address area 1024 Byte 
Output I/O address area 1024 Byte 
Input process image maximal 128 Byte 
Output process image maximal 128 Byte 
Digital inputs 8192  
Digital outputs 8192  
Digital inputs central 512  
Digital outputs central 512  
Integrated digital inputs - 
Integrated digital outputs - 
Analog inputs 512  
Analog outputs 512  
Analog inputs, central 128  
Analog outputs, central 128  
Integrated analog inputs - 
Integrated analog outputs - 
Communication functions  
PG/OP channel  
Global data communication  
Number of GD circuits, max. 4  
Size of GD packets, max. 22 Byte 
S7 basic communication  
S7 basic communication, user data per job 76 Byte 
S7 communication  
S7 communication as server  
S7 communication as client - 
S7 communication, user data per job 160 Byte 
Number of connections, max. 16  
Functionality Sub-D interfaces  
Type MP²I 
Type of interface RS485 
Connector Sub-D, 9-pin, female 
Electrically isolated - 
MPI  
MP²I (MPI/RS232)  
DP master - 
DP slave - 
Point-to-point interface - 
5V DC Power supply max. 90mA, non-isolated 
24V DC Power supply max. 100mA, non-isolated 
  
Type DP 
Type of interface RS485 
Connector Sub-D, 9-pin, female 
Electrically isolated  
MPI - 
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Order no. 214-2BM06 
MP²I (MPI/RS232) - 
DP master  
DP slave - 
Point-to-point interface - 
CAN - 
5V DC Power supply max. 90mA, isolated 
24V DC Power supply - 
Functionality MPI  
Number of connections, max. 16  
PG/OP channel  
Routing - 
Global data communication  
S7 basic communication  
S7 communication  
S7 communication as server  
S7 communication as client - 
Transmission speed, min. 19.2 kbit/s 
Transmission speed, max. 187.5 kbit/s 
Functionality PROFIBUS master  
PG/OP channel  
Routing - 
S7 basic communication - 
S7 communication - 
S7 communication as server - 
S7 communication as client - 
Equidistance support - 
Isochronous mode - 
SYNC/FREEZE - 
Activation/deactivation of DP slaves  
Direct data exchange (slave-to-slave 
communication) 

- 

DPV1 - 
Transmission speed, min. 9.6 kbit/s 
Transmission speed, max. 12 Mbit/s 
Number of DP slaves, max. 64  
Address range inputs, max. 1 KB 
Address range outputs, max. 1 KB 
User data inputs per slave, max. 244 Byte 
User data outputs per slave, max. 244 Byte 
Datasizes  
Input bytes 0 
Output bytes 0 
Parameter bytes 4 
Diagnostic bytes 0 
Housing  
Material PPE / PA 6.6 
Mounting Profile rail 35 mm 
Mechanical data  
Dimensions (WxHxD) 50.8 x 76 x 80 mm 
Weight 150 g 
Environmental conditions  
Operating temperature 0 °C to 60 °C 
Storage temperature -25 °C to 70 °C 
Certifications  
UL certification in preparation 

 

 



Chapter 2   Hardware description Manual VIPA System 200V 

2-10  HB97E - CPU - RE_21x-2BM06 - Rev. 13/21 

 



Manual VIPA System 200V Chapter 3   Deployment CPU 21x-2BM06 

HB97E - CPU - RE_21x-2BM06 - Rev. 13/21  3-1 

Chapter 3  Deployment CPU 21x-2BM06 
 

This chapter describes the deployment of the CPU in the System 200V. 
The description refers directly to the CPU and to the deployment in 
connection with peripheral modules, mounted on a profile rail together with 
the CPU at the backplane bus. 
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Assembly 
 

Note! 
Information about assembly and cabling may be found at chapter "Basics 
and Assembly". 
 

Start-up behavior 
 

When the CPU is delivered it has been reset. After the power supply has 
been switched on, the CPU changes to the operating mode the operating 
mode lever shows. After a STOP→RUN transition the CPU switches to 
RUN without program. 
 
Note! 
Due to a long storage of the CPU, the battery may be discharged 
excessively. Please connect the CPU at least for 24 hours to the power 
supply, to achieve the full buffer capacity. 
 
The CPU switches to RUN with the program stored in the battery buffered 
RAM. 
 
 
The accumulator/battery is automatically loaded via the integrated power 
supply and guarantees a buffer for max. 30 days. If this time is exceeded, 
the battery may be totally discharged. This means that the battery buffered 
RAM is deleted. 
In this state, the CPU executes an overall reset because with an empty 
battery the RAM content is undefined. If a MMC with a S7PROG.WLD is 
plugged, program code and data blocks are transferred from the MMC into 
the work memory of the CPU. 
If there is no MMC, the project from the internal Flash is loaded. 
Depending on the position of the operating mode switch, the CPU remains 
in STOP respectively switches to RUN. Due to the battery error the CPU 
can only boot if there was an OB81 configured. Otherwise a manual restart 
(STOP/RUN) respectively PG command is necessary. 
On a start-up with an empty battery the SF LED is on and thus points to an 
entry in the diagnostic buffer. Information about the Event-IDs can be found 
at "VIPA specific diagnostic entries". 
 

Attention! 
After a power reset and with an empty battery the CPU starts with a BAT 
error and executes an overall reset.  

     

Turn on power 
supply 

     

Boot procedure with 
valid data in the 
CPU 

Boot procedure 
with empty battery 
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Addressing 
 

To provide specific addressing of the installed peripheral modules, certain 
addresses must be allocated in the CPU. 
The CPU contains a peripheral area (addresses 0 ... 1023) and a process 
image of the inputs and the outputs (for both each address 0 ... 127). 
When the CPU is initialized it automatically assigns peripheral addresses to 
the digital input/output modules starting from 0.  
If there is no hardware projecting, analog modules are allocated to even 
addresses starting from address 128.  
 

The signaling states of the lower addresses (0 ... 127) are additionally 
saved in a special memory area called the process image.  
The process image is divided into two parts: 
• process image of the inputs (PII) 
• process image of the outputs (PIQ) 
 

Peripheral area
0
.
.
.

127

128
.
.
.

1023

Process image
0
.
.
.

127

0
.
.
.

127

Inputs
PII

Outputs
PIQ

Digital modules

Analog modules

 
 
The process image is updated automatically when a cycle has been 
completed.  
 

You may access the modules by means of read or write operations on the 
peripheral bytes or on the process image. 
 

Note! 
Please remember that you may access different modules by means of read 
and write operations on the same address.  
The addressing ranges of digital and analog modules are different when 
they are addressed automatically. 
Digital modules:   0 ... 127 
Analog modules: 128 ... 1023 

Automatic 
addressing 

Signaling states in 
the process image 

Read/write access 
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The following figure illustrates the automatic allocation of addresses: 
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You may change the allocated addresses at any time by means of the 
Siemens SIMATIC manager. In this way you may also change the addres-
ses of analog modules to the range covered by the process image  
(0 ... 127) and address digital modules above 127. 
The following pages describe the required preparations and the procedure 
for this type of configuration. 
 
 

Example for auto-
matic address 
allocation 

Modifying allocated 
addresses by 
configuration 
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Hints for the deployment of the MPI interface 
 

The MP2I jack combines 2 interfaces in 1: 
• MP interface 
• RS232 interface 
Please regard that the RS232 functionality is only available by using the 
Green Cable from VIPA.   
 

The MP interface provides the data transfer between CPUs and PCs. In a 
bus communication you may transfer programs and data between the 
CPUs interconnected via MPI. 
Connecting a common MPI cable, the MPI jack supports the full MPI 
functionality. 
 
 

Important notes for the deployment of MPI cables! 
Deploying MPI cables at the CPUs from VIPA, you have to make sure that 
Pin 1 is not connected. This may cause transfer problems and in some 
cases damage the CPU! 
Especially PROFIBUS cables from Siemens, like e.g. the  
6XV1 830-1CH30, must not be deployed at MP2I jack. 
For damages caused by nonobservance of these notes and at improper 
deployment, VIPA does not take liability! 
 

 
For the serial data transfer from your PC, you normally need a MPI 
transducer. Fortunately you may also use the "Green Cable" from VIPA. 
You can order this under the order no. VIPA 950-0KB00. 
 

 

The "Green Cable" supports a serial point-to-point connection for data 
transfer via the MP2I jack exclusively for VIPA CPUs. 

 
 

What is MP2I? 

Deployment as  
MP interface 

 

Deployment as 
RS232 interface only 
via "Green Cable" 



Chapter 3   Deployment CPU 21x-2BM06 Manual VIPA System 200V 

3-6  HB97E - CPU - RE_21x-2BM06 - Rev. 13/21 

SIMATIC Manager - Limitations  
 

Since the VIPA-CPU is configured as CPU 315-2AG10 in the Siemens 
SIMATIC manager, there are limitations with the configuration of the VIPA-
CPU, which are in the following described. 
 

• OB 55 "Status interrupt" is not supported by the VIPA-CPU. 
• OB 56 "Update interrupt" is not supported by the VIPA-CPU. 
• The phase shift, available for the OB 35 "Watchdog" in the Siemens 

SIMATIC manager, is not evaluated by the VIPA-CPU. 
 

• "Plant designation" and "location identifier" in the Siemens SIMATIC 
manager are not supported by the VIPA-CPU. 

• In contrast to the Siemens CPU 315-2AG10 with a periphery address 
area 0 to 2047, the periphery address area of the VIPA-CPU is limited to 
0 to 1023. 

• The bit memory (retentive memory) area is limited to 0 to 1023. 
 

General 

Operating  
blocks - OBs 

Further limitations 
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Hardware configuration - CPU 
 

For the project engineering of the CPU 21x and the other System 200V 
modules connected to the same VIPA bus, the hardware configurator from 
Siemens is to be used. 
To address the directly plugged peripheral modules, you have to assign a 
special address in the CPU to every module.  
The address allocation and the parameterization of the modules takes 
place in the Siemens SIMATIC manager as a virtual PROFIBUS system. 
For the PROFIBUS interface is standardized software sided, the 
functionality is guaranteed by including a GSD-file into the Siemens  
SIMATIC manager. 
Transfer your project into the CPU via the MPI interface. 
 

 

The following conditions must be fulfilled for project engineering: 
• The Siemens SIMATIC manager is installed at PC respectively PU 
• The GSD files have been included in Siemens hardware configurator 
• Serial connection to the CPU (e.g. MPI-Adapter) 
 

Note! 
The configuration of the CPU requires a thorough knowledge of the 
Siemens SIMATIC manager and the hardware configurator! 
 

• Go to www.vipa.com > Service > Download > PROFIBUS GSD files and 
download the file System_100V_-_200V_Vxxx.zip. 

• Extract the file to your work directory. The vipa_21x.gsd (German) 
respectively vipa_21x.gse (English) can be found at the directory 
CPU21x. 

• Start the Siemens hardware configurator and close every project. 
• Go to Options > Install new GSD file 
• Navigate to the directory CPU21x and choose the corresponding file 

vipa_21x.gsd (German) or vipa_21x.gse (English) 
Now the modules of the VIPA System 200V are integrated in the hardware 
catalog at PROFIBUS-DP \ Additional field devices \ I/O \ 
VIPA_System_200V. 
 
 

Overview 

Requirements 

     

Including the  
GSD-file 
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To be compatible with the Siemens SIMATIC manager the following steps 
should be executed: 
 

 

Module
CPU 21x-2BM06

Slot
1
2
...

PB-
Addr.:1

PB-
Addr.:2

(1) VIPA_CPU
CPU 21x

CPU 214

PW

SF

FC

MC

R

S

RN
ST
MR

MMC

2

Module

CPU 315-2DP 
DP

Slot
1
2
X2
3

PROFIBUS (1): DP master system (1)

 

• Start the hardware configurator from 
Siemens with a new project. 

• Insert a profile rail from the hardware 
catalog. 

• Place at slot 2 the following CPU from 
Siemens:  
CPU 315-2DP (315-2AG10-0AB00 
V2.6) 

• For the System 200V create a new   
PROFIBUS subnet. 

• Attach the slave system 
"VIPA_CPU21x" to the subnet with 
PROFIBUS-Address 1.  
After installing the vipa_21x.gsd the 
slave system may be found at the 
hardware catalog at PROFIBUS DP > 
Additional field devices > IO > 
VIPA_System_200V. 

• Place always at the 1. slot the 
corresponding CPU 21x-2BM06, by 
taking it from the hardware catalog.  

 

 

Proceeding 
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Hardware configuration - I/O modules 
 

After the hardware configuration of the CPU place the System 200V 
modules in the plugged sequence. 
In order to address the installed peripheral modules individually, specific 
addresses in the CPU have to be assigned to them. 
 

Modul
CPU
DI
DO
DIO
AI
AO

Slot
1
2
3
4
5
6
7
8
...

Parameter DIO

Param : .........
Param : .........
Param : .........
Param : .........

Param : .........
Param : .........
Param : .........
Param : .........D

I 8
xD

C
24

V

D
O

 8
xD

C
24

V

D
IO

 8
xD

C
24

V

AI
 4

x1
2B

it

AO
 4

x1
2B

it

CPU 21x

PB-
Addr.:1

PB-
Addr.:2

(1) VIPA_CPU
CPU 21x

CPU 214

PW

SF

FC

MC

R

S

RN

ST
MR

MMC

2

Module

CPU 315-2DP 
DP

Slot
1
2
X2
3

PROFIBUS (1): DP master system (1)

 
 

For parameterization double-click during the project engineering at the slot 
overview on the module you want to parameterize. In the appearing dialog 
window you may set the wanted parameters. 
 
By using the SFCs 55, 56 and 57 you may alter and transfer parameters for 
wanted modules during runtime. 
For this you have to store the module specific parameters in so called 
"record sets". 
More detailed information about the structure of the record sets is to find in 
the according module description. 
 
 
 
 

Hardware 
configuration of 
the modules  

Parameterization  

Parameterization 
during runtime 
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Setting CPU parameters 
 

Since the CPU from VIPA is to be configured as Siemens CPU 315-2DP 
(315-2AG10-0AB00 V2.6) in the Siemens hardware configurator, the 
parameters of the VIPA CPU may be set with "Object properties" of the 
CPU 315-2DP during hardware configuration. 
Via a double-click on the CPU 315-2DP the parameter window of the CPU 
may be accessed. 
Using the registers you get access to every standard parameter of the 
CPU. 
 

(1) VIPA_CPU
CPU 21x

CPU 214

PW

SF

FC

MC

R

S

RN
ST

MR

MMC

2

Module

CPU 315-2DP 
DP

Slot
1
2
X2
3

Parameter CPU

Param : .........
Param : .........
Param : .........
Param : .........

Param : .........
Param : .........
Param : .........
Param : .........

 
 

The CPU does not evaluate each parameter, which may be set at the 
hardware configuration.  
The following parameters are supported by the CPU at this time: 
 
 
 
The short description of the Siemens CPU 315-2AG10 is CPU 315-2DP. 
 
Order number and firmware are identical to the details in the "hardware 
catalog" window. 
 
The Name field provides the short description of the CPU. If you change 
the name the new name appears in the Siemens SIMATIC manager. 
  
In this field information about the module may be entered. 
 
 
 
If the checkbox for "Startup when expected/actual configuration differ" is 
deselected and at least one module is not located at its configured slot or if 
another type of module is inserted there instead, then the CPU does not 
switch to RUN mode and remains in STOP mode. 
If the checkbox for "Startup when expected/actual configuration differ" is 
selected, then the CPU starts even if there are modules not located in their 
configured slots of if another type of module is inserted there instead, such 
as during an initial system start-up. 

Parameterization 
via Siemens  
CPU 315-2AG10 

Supported 
parameters 

General 

Short description 

Order No. / 
Firmware 

Name 

Comment 

Startup 

Startup when 
expected/actual 
configuration differs 
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This operation specifies the maximum time for the ready message of every 
configured module after PowerON. Here connected PROFIBUS DP slaves 
are also considered until they are parameterized. If the modules do not 
send a ready message to the CPU by the time the monitoring time has 
expired, the actual configuration becomes unequal to the preset 
configuration. 
 
The maximum time for the transfer of parameters to parameterizable 
modules. If not every module has been assigned parameters by the time 
this monitoring time has expired; the actual configuration becomes unequal 
to the preset configuration. 
 

 
 
This parameter is not relevant. 
 
 
Here the scan cycle monitoring time in milliseconds may be set. If the scan 
cycle time exceeds the scan cycle monitoring time, the CPU enters the 
STOP mode. Possible reasons for exceeding the time are: 
• Communication processes 
• a series of interrupt events 
• an error in the CPU program 
 
This parameter is not relevant. 
 
 
The preset reaction of the CPU may be changed to an I/O access error that 
occurs during the update of the process image by the system. 
The VIPA CPU is preset such that OB 85 is not called if an I/O access error 
occurs and no entry is made in the diagnostic buffer either. 
 
Activate the check box if you want to use clock memory and enter the 
number of the memory byte. 
 

Note! 
The selected memory byte cannot be used for temporary data storage. 
 
 

Monitoring time for 
ready message by 
modules [100ms] 

Monitoring time for 
transfer of 
parameters to 
modules [100ms] 

Cycle/Clock 
memory 
Update OB1 
process image 
cyclically 
 
Scan cycle 
monitoring time 

Minimum scan  
cycle time 

OB85 call up at I/O 
access error 

Clock memory 
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Enter the number of retentive memory bytes from memory byte 0 onwards. 
Retentive values > 1024 are not allowed. 
 
 
Enter the number of retentive S7 timers from T0 onwards. Each S7 timer 
occupies 2bytes. 
 
Enter the number of retentive S7 counter from C0 onwards. 
 
 
These parameters are not relevant. 
 

 
 
Here the priorities are displayed, according to which the hardware interrupt 
OBs are processed (hardware interrupt, time-delay interrupt, async. error 
interrupts).  
  
 
 
 
Here the priorities may be specified according to which the time-of-day 
interrupt is processed. 
With priority "0" the corresponding OB is deactivated. 
 
Activate the check box of the time-of-day interrupt OBs if these are to be 
automatically started on complete restart. 
 
Select how often the interrupts are to be triggered. Intervals ranging from 
every minute to yearly are available. The intervals apply to the settings 
made for start date and time. 
 
Enter date and time of the first execution of the time-of-day interrupt. 
 
This parameter is not supported. 
 

 
 
Here the priorities may be specified according to which the corresponding 
cyclic interrupt is processed. With priority "0" the corresponding interrupt is 
deactivated. 
 

Retentive Memory 

Number of Memory 
Bytes from MB0 

Number of S7 
Timers from T0 

Number of S7 
Counters from C0 

Areas 

Interrupts 

Priority 

Time-of-day 
interrupts 

Priority 

Active 

Execution 

Start date / time 

Process image 
partition 

Cyclic interrupts 

Priority 
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Enter the time intervals in ms, in which the watchdog interrupt OBs should 
be processed. The start time for the clock is when the operating mode 
switch is moved from STOP to RUN. 
 
This parameter is not supported. 
 
  

 
 
Here 1 of 3 protection levels may be set to protect the CPU from 
unauthorized access. 
Protection level 1 (default setting): 
• No password adjustable, no restrictions 
Protection level 2 with password: 
• Authorized users: read and write access 
• Unauthorized user: read access only 
Protection level 3: 
• Authorized users: read and write access 
• Unauthorized user: no read and write access 
 

Execution 

Process image 
partition 

Protection 

Level of protection 
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Project transfer 
 

There are the following possibilities for project transfer into the CPU: 
• Transfer via MPI 
• Transfer via MMC when using a MMC programmer 
 
 
 

The structure of a MPI net is electrically identical with the structure of a 
PROFIBUS net. This means the same rules are valid and you use the 
same components for the build-up. The single participants are connected 
with each other via bus interface plugs and PROFIBUS cables. Per default 
the MPI net runs with 187.5kbaud. VIPA CPUs are delivered with MPI 
address 2. 
 

The MPI programming cables are available at VIPA in different variants. 
The cables provide a RS232 res. USB plug for the PC and a bus enabled 
RS485 plug for the CPU. 
Due to the RS485 connection you may plug the MPI programming cables 
directly to an already plugged plug on the RS485 jack. Every bus 
participant identifies itself at the bus with an unique address, in the course 
of the address 0 is reserved for programming devices. 
 

A cable has to be terminated with its surge impedance. For this you switch 
on the terminating resistor at the first and the last participant of a network or 
a segment. 
Please make sure that the participants with the activated terminating 
resistors are always power supplied. Otherwise it may cause interferences 
on the bus. 
Transfer with MPI programming cable (MPI communication) 

M
P

I

U
S

B
-M

P
I A

d
apter

P
ow

er

A
ctive

E
rror

VIPA 950-0KB31

U
S

B

V
IPA

MPI programming cable

STEP7
from Siemens

MPI netTerminating Terminating

 
Transfer via Green Cable (serial communication) 
Via exclusively direct plugging of the Green Cable to a MP2I jack you may 
establish a serial connection between PC and CPU. Set the PC-COM port 
and the transfer rate 38400Baud at Local port. The settings of the register 
MPI are ignored at employment of the Green Cable. 

Green Cable

STEP7
from Siemens

MPI net
 

Overview 

Transfer via MPI 

MPI programming 
cable 

Terminating resistor 
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Hints for configuring a MPI interface are to find in the documentation of 
your programming software.  
The "Green Cable" has the order number VIPA 950-0KB00. 
 

Attention! 
Please regard, that you may use the "Green Cable" exclusively at VIPA 
CPUs with MP2I-interface! 
Please regard the hints for deploying the Green Cable and the MP2I jack! 
 

• Connect your PC to the MPI jack of your CPU via a MPI programming 
cable.  

• Load your project in the SIMATIC manager from Siemens. 
• Choose in the menu Options > Set PG/PC interface 
• Select in the according list the "PC Adapter (MPI)"; if appropriate you 

have to add it first, then click on [Properties]. 
• Set in the register MPI the transfer parameters of your MPI net and type 

a valid address. 
• Switch to the register Local connection 
• Set the COM port of the PC and the transfer rate 38400Baud for the MPI 

programming cable from VIPA.  
• Via PLC > Load to module you may transfer your project via MPI to the 

CPU and save it on a MMC via PLC > Copy RAM to ROM if one is 
plugged. 

 

Note! 
Please make sure to adjust the transfer rate to 38400Baud when using the 
"Green Cable" from VIPA.  
 

Configure MPI 

 

Approach transfer 
via MPI interface 
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The Green Cable is a green connection cable, manufactured exclusively for 
the deployment at VIPA System components. 
The Green Cable is a programming and download cable for VIPA CPUs 
MP2I jack and VIPA field bus masters. The Green Cable from VIPA is 
available under the order no. VIPA 950-0KB00. 
 
The Green Cable allows you to: 

 

• transfer projects serial  
Avoiding high hardware needs (MPI transducer, etc.) you may realize a 
serial point-to-point connection via the Green Cable and the MP2I jack. 
This allows you to connect components to your VIPA-CPU that are able 
to communicate serial via a MPI adapter like e.g. a visualization system.

• execute firmware updates of the CPUs and field bus masters 
Via the Green Cable and an upload application you may update the 
firmware of all recent VIPA CPUs with MP2I jack and certain field bus 
masters (see Note). 

 
 

Important notes for the deployment of the Green Cable 
Nonobservance of the following notes may cause damages on system 
components. 
For damages caused by nonobservance of the following notes and at 
improper deployment, VIPA does not take liability! 
 

Note to the application area 
The Green Cable may exclusively deployed directly at the concerning jacks 
of the VIPA components (in between plugs are not permitted). E.g. a MPI 
cable has to be disconnected if you want to connect a Green Cable. 
At this time, the following components support Green Cable: 
VIPA CPUs with MP2I jack and field bus masters from VIPA. 
 

Note to the lengthening 
The lengthening of the Green Cable with another Green Cable res. The 
combination with further MPI cables is not permitted and causes damages 
of the connected components! 
The Green Cable may only be lengthened with a 1:1 cable  
(all 9 pins are connected 1:1). 
 

Hints for the 
Green Cable  
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The MMC (Memory Card) serves as external transfer and storage medium. 
There may be stored several projects and sub-directories on a MMC 
storage module. Please regard that your current project is stored in the root 
directory and has one of the following file names: 
• S7PROG.WLD 
• S7PROGF.WLD 
• AUTOLOAD.WLD 
With File > Memory Card File > New in the Siemens SIMATIC manager a  
new wld file may be created. After the creation copy the blocks from the 
project blocks folder and the System data into the wld file. 
 
The transfer of the application program from the MMC into the CPU takes 
place depending on the file name after an overall reset or PowerON. 
• S7PROG.WLD is read from the MMC after overall reset and transferred 

into the battery buffered RAM. 
• S7PROGF.WLD is read from the MMC after overall reset and 

transferred into the battery buffered RAM and additionally into the Flash 
memory. An access to the Flash memory only takes place at empty 
battery of the buffer and when no MMC with user program is plugged-in. 

• AUTOLOAD.WLD is read after PowerON from the MMC and transferred 
into the battery-buffered RAM . 

During the transfer the "MC" LED blinks. Please regard that your user 
memory serves for enough space, otherwise your user program is not 
completely loaded and the SF LED gets on.  Execute a compression before 
the transfer, for this does not happen automatically. 
 
When the MMC has been installed, the write command stores the content 
of the battery buffered RAM as S7PROG.WLD on the MMC and in the 
internal Flash memory.  
The write command is controlled by means of the block area of the 
Siemens SIMATIC manager PLC > Copy RAM to ROM. During the write 
process the "MC"-LED of the CPU is blinking. When the LED expires the 
write process is finished. 
If this project is to be loaded automatically from the MMC with PowerON, 
you have to rename this on the MMC to AUTOLOAD.WLD. 
 
After a MMC access, an ID is written into the diagnostic buffer of the CPU. 
To monitor the diagnosis entries, you select PLC > Module Information in 
the Siemens SIMATIC manager. Via the register "Diagnostic Buffer" you 
reach the diagnosis window.  
Information about the Event-IDs can be found at "VIPA specific diagnostic 
entries". 

Transfer via 
MMC 

Transfer  
MMC →→→→ CPU 

Transfer  
CPU →→→→ MMC 

Transfer control 
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Operating modes 
 

The CPU can be in one of 3 operating modes: 
• Operating mode STOP 
• Operating mode START-UP 
• Operating mode RUN 
 
Certain conditions in the operating modes START-UP and RUN require a 
specific reaction from the system program. In this case the application 
interface is often provided by a call to an organization block that was 
included specifically for this event. 
 

• The application program is not processed. 
• If there has been a processing before, the values of counters, timers, 

flags and the process image are retained during the transition to the 
STOP mode. 

• Outputs are inhibited, i.e. all digital outputs are disabled. 
• RUN-LED (R)  off 
• STOP-LED (S) on 
 

• During the transition from STOP to RUN the system calls the start-up 
organization block OB 100. The processing time for this OB is not 
monitored. The start-up OB may issue calls to other blocks. 

• All digital outputs are disabled during the start-up, i.e. outputs are 
inhibited. 

• RUN-LED blinks as soon as the OB 100 is operated and for at least 
   3s, even if the start-up time is shorter or the CPU gets to 
   STOP due to an error. This indicates the start-up. 

• STOP-LED off 
When the CPU has completed the start-up OB, it assumes the operating 
mode RUN. 
 

• The application program in OB 1 is processed in a cycle. Under the 
control of alarms other program sections can be included in the cycle. 

• All timers and counters being started by the program are active and the 
process image is updated with every cycle. 

• The BASP-signal (outputs inhibited) is deactivated, i.e. all digital outputs 
are enabled. 

• RUN-LED on 
• STOP-LED off 

Overview 

Operating mode 
STOP 

Operating mode 
START-UP 

Operating mode 
RUN 
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The CPUs include security mechanisms like a watchdog (100ms) and a 
parameterizable cycle time surveillance (parameterizable min. 1ms) that 
stop res. execute a RESET at the CPU in case of an error and set it into a 
defined STOP state. 
The VIPA CPUs are developed function secure and have the following 
system properties: 
 

Event concerns Effect 
RUN → STOP general BASP (Befehls-Ausgabe-Sperre, i.e. command 

output lock) is set. 
 central digital outputs The outputs are disabled. 
 central analog outputs The Outputs are disabled. 

- Voltage outputs issue 0V 
- Current outputs 0...20mA issue 0mA 
- Current outputs 4...20mA issue 4mA  
If configured also substitute values may be  
issued. 

 decentral outputs Same behavior as the central digital/analog 
outputs. 

 decentral inputs The inputs are cyclically be read by the decentra-
lized station and the recent values are put at 
disposal. 

STOP → RUN 
res. PowerON 

general First the PII is deleted, then OB 100 is called. After 
the execution of the OB, the BASP is reset and the 
cycle starts with:   
Delete PIO → Read PII → OB 1. 

 central analog outputs The behavior of the outputs at restart can be 
preset.  

 decentral inputs The inputs are cyclically be read by the decentra-
lized station and the recent values are put at 
disposal. 

RUN general The program execution happens cyclically and can 
therefore be foreseen:  
Read PII → OB 1 → Write PIO. 

 
PII = Process image inputs 
PIO = Process image outputs 

 

Function security 
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Overall reset 
 

During the overall reset the entire user memory is erased. Data located in 
the memory card is not affected. 
You have 2 options to initiate an overall reset: 
• initiate the overall reset by means of the function selector switch 
• initiate the overall reset by means of the configuration software e.g. 

Siemens SIMATIC manager 
 
Note! 
You should always issue an overall reset to your CPU before loading an 
application program into your CPU to ensure that all blocks have been 
cleared from the CPU. 
 

Condition 
The operating mode of the CPU is STOP. Place the function selector on the 
CPU in position "ST" → the S-LED is on. 
 

Overall reset 
• Place the function selector in the position MR and hold it in this position 

for app. 3 seconds. → The S-LED changes from blinking to permanently 
on. 

• Place the function selector in the position ST and switch it to MR and 
quickly back to ST within a period of less than 3 seconds.  
→ The S-LED blinks (overall reset procedure). 

• The overall reset has been completed when the S-LED is on 
permanently. → The S-LED is on. 

 
The following figure illustrates the above procedure: 
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Overview 

     

Overall reset by 
means of the 
function selector 
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If there is a project S7PROG.WLD on the MMC, the CPU attempts to 
reload this project from MMC → the MC LED is on. 
When the reload has been completed the LED is extinguished. The 
operating mode of the CPU will be STOP or RUN, depending on the 
position of the function selector. 
 

Condition 
The operating mode of the CPU must be STOP.  
You may place the CPU in STOP mode by the menu command 
PLC > Operating mode. 
 
Overall reset 
You may request the overall reset by means of the menu command PLC > 
Clean/Reset. 
In the dialog window you may place your CPU in STOP mode and start the 
overall reset if this has not been done as yet. 
The S-LED blinks during the overall reset procedure. 
When the S-LED is on permanently the overall reset procedure has been 
completed. 
 

At this point the CPU attempts to reload the parameters and the program 
from the memory card. → The MC LED is on. 
When the reload has been completed, the LED expires. The operating 
mode of the CPU will be STOP or RUN, depending on the position of the 
function selector. 
 

A Factory reset deletes the internal RAM of the CPU completely and sets it 
back to the delivery state. 
Please regard that the MPI address is also set back to default 2! 
More information may be found at the part "Factory reset" further below. 
 
 

Automatic reload 

Overall reset by 
means of the 
Siemens SIMATIC 
manager 

Automatic reload 

Reset to factory 
setting 
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Firmware update 
 

There is the opportunity to execute a firmware update for the CPU and its 
components via MMC. For this an accordingly prepared MMC must be in 
the CPU during the startup. 
So a firmware files can be recognized and assigned with startup, a file 
name is reserved for each updateable component (see table below). 
After PowerON and CPU STOP the CPU checks if there is a firmware file 
on the MMC. If this firmware version is different to the existing firmware 
version, this is indicated by blinking of the LEDs and the firmware may be 
installed by an update request. 
 

The latest firmware versions are to be found in the service area at 
www.vipa.com 
 

A label on the rear of the module indicates the firmware version. 
You may display the current firmware version of your CPU via the Siemens 
SIMATIC manager. To display the firmware version, you go online with the 
CPU via your PG or PC and start the Siemens SIMATIC manager.  
Via PLC > Module status, register "General", the current firmware version is 
evaluated and displayed. 
 

 

• Go to www.vipa.com 
• Click on Service > Download > Firmware. 
• Navigate via System 200V > CPU to your CPU and download according 

to your hardware version the zip file to your PC. 
• Open the zip file and copy the bin file to your MMC. 
• Rename this to firmware.bin. 
 
By means of a reserved file name in the CPU 21x-2BM06 you may transfer 
a firmware per MMC: 
 
Component File name  

order no._release_version.ZIP 
New file name  
at MMC 

CPU Bx000... .bin firmware.bin 
DPM Bx000589.bin dpm00.bin 

 

 
 

Overview 

Latest Firmware at 
www.vipa.com 

Find out CPU  
firmware version 

Load firmware and 
transfer it to MMC 
with reserved file 
name 

Reserved file 
names 
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Attention! 
When installing a new firmware you have to be extremely careful. Under 
certain circumstances you may destroy the CPU, for example if the voltage 
supply is interrupted during transfer or if the firmware file is defective. 
In this case, please call the VIPA-Hotline! 
Please regard that the version of the update firmware has to be different 
from the existing firmware otherwise no update is executed. 
 

1. Switch the operating mode switch of your CPU in position ST. Turn off 
the voltage supply. Plug the MMC with the firmware files into the CPU. 
Please take care of the correct plug-in direction of the MMC. Turn on 
the voltage supply. 

2. After a short boot-up time, the alternate blinking of the LEDs SF and FC 
shows that at least a differing firmware file was found on the MMC. 

3. You start the transfer of the firmware as soon as you tip the operating 
mode switch lever downwards to MR within 10s and leave it in ST 
position. 

4. During the update process, the LEDs SF and FC are alternately blinking 
and MC LED is on. This may last several minutes. 

5. The update is successful finished when the LEDs PW, S, SF, FC and 
MC are on. If they are blinking fast, an error occurred. 

6. Turn Power OFF and ON. Now it is checked by the CPU, whether 
further current firmware versions are available at the MMC. If so, again 
the LEDs SF and FC flash after a short start-up period. Continue with 
point 3. 
If the LEDs do not flash, the firmware update is ready.  
Now a factory reset should be executed (see next page). After that the 
CPU is ready for duty. 
 

Power OFF/ON
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ST

MR

RN

ST

MR

R

S

PW

SF

FC

MC
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R
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PW

SF

FC

MC
10 Sec.

Tip

R

S

PW

SF

FC

MC

R

S

PW

SF

FC

MC

Preparation Firmware 
recognized
at MMC

Start update Update runs

R

S

PW

SF

FC

MC

Update
terminates
error free

R

S
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MC

Error
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Power
OFF/ON
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Transfer firmware 
from MMC into 
CPU 
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Factory reset 
 

With the following proceeding the internal RAM of the CPU is completely 
deleted and the CPU is reset to delivery state.  
Please note that here also the MPI address is reset to the address 2! 
 
1. Switch the CPU to STOP. 
2. Push the operating mode switch down to position MR for 30s. Here the 

S LED flashes. After a few seconds the stop LED changes to static 
light. Now the S LED changes between static light and flashing. Starting 
here count the static light states of the S LED. 

3. After the 6. static light release the operating mode switch and tip it 
downwards to MR. Now the RUN LED lights up once. This means that 
the RAM was deleted completely. 

4. For the confirmation of the resetting procedure the LEDs PW and S are 
on.  

5. Then you have to switch the power supply off and on. 
 
The proceeding is shown in the following Illustration: 
 

RN

ST

MR

30 Sec.

Tip

R

S

PW

SF

FC

MC

CPU in 
STOP

Request factory reset Start factory reset Factory reset
executed

1 3

R

S

PW

SF

FC

MC

R

S

PW

SF

FC

MC

6x RN

ST

MR

RN

ST

MR

Tip

1 Sec.

2 4

Power
OFF/ON

5

R

S

PW

SF

FC

MC

R

S

PW

SF

FC

MC

 
 

Note! 
After the firmware update you always should execute a Factory reset. 
 
 

Proceeding 
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VIPA specific diagnostic entries 
 

You may read the diagnostic buffer of the CPU via the Siemens  SIMATIC 
manager. Besides of the standard entries in the diagnostic buffer, the VIPA 
CPUs support some additional specific entries in form of event-IDs. 
 

To monitor the diagnostic entries you choose the option PLC > Module 
Information in the Siemens SIMATIC manager. Via the register "Diagnostic 
Buffer" you reach the diagnostic window: 
 

Module information

Diagnostic Buffer

Nr.
8
9
10
11
12
13

Time of day
...
...
13:18:11:370
...
...
...

Date
...
...
19.12.2011
...
...
...

Event
...
...
Event-ID: 16# E0CC
...
...
...

Path: Accessible Nodes MPI = 2 Operating mode CPU: RUN

Details:

...

VIPA-ID

... ... ... ...

... ... ... ... ... ...

 
 
The diagnosis is independent from the operating mode of the CPU. You 
may store a max. of 100 diagnostic entries in the CPU. 
The following page shows an overview of the VIPA specific Event-IDs. 
 
 

Entries in the 
diagnostic buffer 

Monitoring the 
diagnostic entries 
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Event-ID Description 
0xE003 Error at access to I/O devices  

Zinfo1: I/O address 
Zinfo2: Slot 

0xE004 Multiple parameterization of a I/O address  
Zinfo1: I/O address 
Zinfo2: Slot 

0xE005 Internal error – Please contact the VIPA-Hotline! 
0xE006 Internal error – Please contact the VIPA-Hotline! 
0xE007 Configured in-/output bytes do not fit into I/O area  
0xE008 Internal error – Please contact the VIPA-Hotline! 
0xE009 Error at access to standard back plane bus 
0xE010 Not defined module group at backplane bus recognized 

Zinfo2: Slot 
Zinfo3: Type ID 

0xE011 Master project engineering at Slave-CPU not possible or wrong slave configuration 
0xE012 Error at parameterization 
0xE013 Error at shift register access to VBUS digital modules 
0xE014 Error at Check_Sys 
0xE015 Error at access to the master 

Zinfo2: Slot of the master (32=page frame master) 
0xE016 Maximum block size at master transfer exceeded  

Zinfo1: I/O address  
Zinfo2: Slot 

0xE017 Error at access to integrated slave 
0xE018 Error at mapping of the master I/O devices 
0xE019 Error at standard back plane bus system recognition 
0xE01A Error at recognition of the operating mode (8 / 9 Bit) 

  
0xE0CC Communication error MPI / Serial 

  
0xE100 MMC access error 
0xE101 MMC error file system 
0xE102 MMC error FAT 
0xE104 MMC error at saving 
0xE200 MMC writing finished (Copy Ram to Rom) 
0xE210 MMC reading finished (reload after overall reset) 
0xE300 Internal Flash writing ready  (Copy RAM to ROM) 
0xE310 Internal Flash reading finished (reload after battery failure) 

 
 

Overview of the 
Event-IDs 
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Using test functions for control and monitoring of variables 
 

For troubleshooting purposes and to display the status of certain variables 
you can access certain test functions via the menu item Debug of the 
Siemens SIMATIC manager. 
The status of the operands and the VKE can be displayed by means of the 
test function Debug > Monitor. 
You can modify and/or display the status of variables by means of the test 
function PLC > Monitor/Modify Variables. 
 

This test function displays the current status and the VKE of the different 
operands while the program is being executed.   
It is also possible to enter corrections to the program. 
 

Note! 
When using the test function “Monitor” the PLC must be in RUN mode! 
 

The processing of the states may be interrupted by means of jump 
commands or by timer and process-related alarms. At the breakpoint the 
CPU stops collecting data for the status display and instead of the required 
data it only provides the PG with data containing the value 0. 
For this reason, jumps or time and process alarms can result in the value 
displayed during program execution remaining at 0 for the items below: 
 
• the result of the logical operation VKE 
• Status / AKKU 1 
• AKKU 2 
• Condition byte 
• absolute memory address SAZ. In this case SAZ is followed by a "?". 
 
The interruption of the processing of statuses does not change the 
execution of the program. It only shows that the data displayed is no longer. 

Overview 

Debug > Monitor 
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This test function returns the condition of a selected operand (inputs, 
outputs, flags, data word, counters or timers) at the end of program-
execution.   
This information is obtained from the process image of the selected 
operands. During the "processing check" or in operating mode STOP the 
periphery is read directly from the inputs. Otherwise only the process image 
of the selected operands is displayed. 
 
Control of outputs 
It is possible to check the wiring and proper operation of output-modules.   
You can set outputs to any desired status with or without a control program. 
The process image is not modified but outputs are no longer inhibited. 
 
Control of variables 
The following variables may be modified: 
I, Q, M, T, C and D. 
The process image of binary and digital operands is modified independently 
of the operating mode of the CPU.    
When the operating mode is RUN the program is executed with the 
modified process variable. When the program continues they may, 
however, be modified again without notification. 
Process variables are controlled asynchronously to the execution sequence 
of the program. 
 
 
 

PLC > 
Monitor/Modify 
Variables 
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Chapter 4  PROFIBUS communication 
 

Content of this chapter is the deployment of the CPU 21x-2BM06 with 
PROFIBUS. After a short introduction into the PROFIBUS system, the 
project engineering and the usage with PROFIBUS is shown.  
This chapter ends with information about commissioning and start-up 
behavior of the DP master. 
 

 

Topic     Page 
Chapter 4 PROFIBUS communication ............................................ 4-1 

Overview .............................................................................................. 4-2 
Project engineering CPU with integrated PROFIBUS DP master ......... 4-5 
PROFIBUS installation guidelines ........................................................ 4-7 
Commissioning and Start-up behavior................................................ 4-10 
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Overview 
 

PROFIBUS is an international standard applicable to an open and serial 
field bus for building, manufacturing and process automation that can be 
used to create a low (sensor-/actuator level) or medium (process level) 
performance network of programmable logic controllers.  
PROFIBUS comprises an assortment of compatible versions. The following 
details refer to PROFIBUS DP. 
PROFIBUS DP is a special protocol intended mainly for automation tasks in 
a manufacturing environment. DP is very fast, offers Plug'n'Play facilities 
and provides a cost-effective alternative to parallel cabling between PLC 
and remote I/O. PROFIBUS DP was designed for high-speed data commu-
nication on the sensor-actuator level.  
The data transfer referred to as "Data Exchange" is cyclical. During one bus 
cycle, the master reads input values from the slaves and writes output 
information to the slave. 
 

PROFIBUS distinguishes between active stations (masters) and passive 
stations (slaves). 
Master equipment 
Master equipment controls the data traffic on the bus. There may be also 
several masters at one PROFIBUS. This is referred to as multi master ope-
ration. The bus protocol establishes a logical token ring between the intelli-
gent devices connected to the bus.  
A master of the CPU 21xDPM may send unsolicited messages if it has the 
bus access permission (Token). In the PROFIBUS protocol masters are 
also referred to as active stations.  
Slave equipment 
Typical slave equipment holds data of peripheral equipment, sensors, 
actuators or transducers. The VIPA PROFIBUS are modular slave 
equipment, transferring data between the System 200V periphery and the 
leading master.  
These devices do not have bus access permission in accordance with the 
PROFIBUS standard. They may only acknowledge messages or transfer 
messages to a master if requested by this. Slaves occupy a very limited 
part of the bus protocol. Slaves are also referred to as passive stations. 
 

PROFIBUS DP 

Master and slaves 
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The bus communication protocol provides two procedures for accessing the 
bus:  
 

Communications with the master is also referred to as token passing 
procedure. Token passing guarantees that the station receives access 
permission to the bus. This access right to the bus is passed between the 
stations in form of a "token". A token is a specific message that is 
transferred via the bus.  
When a master possesses the token, it has the access right to the bus and 
is allowed to communicate with all other active and passive stations. The 
token retention time is defined when the system is being configured. When 
the token retention time has expired, the token is passed along to the next 
master that acquires the bus access rights with the token so that this may 
now communicate with all other stations. 
 

Data is exchanged in a fixed repetitive sequence between the master and 
the slaves assigned to this respective master. When you configure the 
system, you define which slaves are assigned to a certain master. You may 
also specify which DP slave is included in the cyclic exchange of 
application data and which ones are excluded. 
The master slave data transfer is divided into parameterization, configura-
tion and data transfer phases. Before a DP slave is included into the data 
transfer phase, the master verifies during the parameterization and configu-
ration phase whether the specified configuration agrees with the effective 
configuration. This verification process checks the device type, format and 
length as well as the number of inputs and outputs. This provides you with 
effective protection against configuration errors. 
The master handles application data transfers independently. In addition 
you may also send new configuration data to a bus coupler. 
If in the status DE „Data Exchange“, the master is sending new basic data 
to the slave and the receipt of the slave transfers the recent input data to 
the master.  
 

Data is referred to as being consistent, if it has the same logical contents. 
Data that belongs together is: the high- and low-byte of an analog value 
(word consistency) and the control and the status byte with the respective 
parameter word, required to access the registers.  
The data consistency during the interaction between the peripherals and 
the controller is only guaranteed for 1Byte. That is, the bits of one byte are 
acquired together and they are transmitted together. Byte-wise consistency 
is sufficient for the processing of digital signals.   

Communication 

Master to Master 

Master slave 
procedure 

Data consistency 
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As transfer medium PROFIBUS uses an isolated drilled 2 core line based 
upon the RS485 interface or a duplex optical waveguide (OWG). The 
transfer rate is for both methods max. 12Mbaud. 
 

The RS485 interface is working with voltage differences. Though it is less 
irritable from failures than a voltage or a current interface. You are able to 
configure the network as well linear as in a tree structure. Your VIPA 
PROFIBUS coupler includes a 9pin slot where you link up the PROFIBUS 
coupler into the PROFIBUS network as a slave. 
The bus structure under RS485 allows an easy connection resp. 
disconnection of stations as well as starting the system step by step. Later 
expansions don’t have any influence on stations that are already integrated. 
The system realizes automatically if one partner had a fail down or if it is 
new in the network. 
 

The optical waveguide system uses monochromatic light impulses. The 
optical waveguide is totally independent from disturbing voltage from other 
machines. An optical waveguide system is built up linear. Every module 
has to be connected with two links: one input link and one back. You don’t 
need to terminate the last module. 
For the structure is a linear one, connecting and disconnecting stations is 
not free of consequences. 
 

Every partner of the PROFIBUS network has to identify itself with a certain 
address. This address may be existing only one time in the bus system and 
has a value between 0 and 125. 
At the CPU 21xDPM you choose the address via your software tool.  
 

To configure the slave connections in your own configuration tool, you’ve 
got all the information about your VIPA modules in form of an electronic 
data sheet file (German: Gerätestammdatei = GSD-file). 
Structure and content of this file are dictated by the PROFIBUS User 
Organization (PNO) and may be seen there. 
Install the GSD-file in your configuration tool. Look for more information in 
the online help of the according tool. 
 

 

Transfer medium 

Electrical system 
over RS485 

Optical system via 
fiber optic (FO) 

Addressing 

Electronic Data 
Sheet  
(GSD-file) 



Manual VIPA System 200V Chapter 4   PROFIBUS communication 

HB97E - CPU - RE_21x-2BM06 - Rev. 13/21  4-5 

Project engineering CPU with integrated PROFIBUS DP master 
 

For the project engineering of the PROFIBUS DP master you have to use 
the hardware manager from Siemens. Your PROFIBUS projects are 
transferred via MPI into the CPU 21x-2BM06 by means of the PLC 
functions. The CPU passes the data on to the PROFIBUS DP master. 
 

Note! 
For the project engineering of the CPU and the PROFIBUS DP master a 
thorough knowledge of the SIMATIC manager and the hardware configura-
tor from Siemens is required! 
 

To be compatible to the Siemens SIMATIC manager, for the System 200V 
the following steps are necessary: 
 
• Configure the CPU 315-2DP with the DP master system (address 2). 
• Add from the VIPA_21x.gsd the PROFIBUS slave "VIPA_CPU21x" with 

address 1.  
• Insert the CPU 21x-2BM06 at the 1. slot of the slave system. 
• Include the directly plugged peripheral modules at the sequencing slots. 
 
• Install the according GSD file for the slave system. 
• select from the hardware catalog the according slave system and drag it 

to the master system. 
• Configure the according periphery modules of the slave system 
• Transfer the project to the CPU 21x-2BM06. 
 
 
 

Overview 

     

Fast introduction 

Master-System 

Slave system 
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• Start the Siemens SIMATIC manager and configure a CPU as described 
at "Hardware configuration - CPU". 

• Designate the station as "...DP master" 
• Add your modules according to the real hardware assembly.  
 

Module
CPU 21x-2BM06
Centralized Periph.
...
...

Slot
1
2
3
...

PB-
Addr.:1

PB-
Addr.:2

(1) VIPA_CPU
CPU 21x

CPU 214

PW

SF

FC

MC

R

S

RN

ST
MR

MM C

2

Module

CPU 315-2DP 
DP

Slot
1
2
X2
3

PROFIBUS (1): DP master system

 
 
• Install the corresponding GSD file of your slave system in the hardware 

configurator. 
• Search the corresponding PROFIBUS DP slave in the hardware catalog 

and drag&drop it to the subnet of your master. 
• Assign a valid PROFIBUS address > 2 to the DP slave 
• Add your modules according to the real hardware assembly.  

 

Module
CPU 21x-2BM06
Centralized Periph.
...
...

Slot
1
2
3
...

PB-
Addr.:1

PB-
Addr.:2

(1) VIPA_CPU
CPU 21x

CPU 214

PW

SF

FC

MC

R

S

RN
ST

MR

MMC

2

Module

CPU 315-2DP 
DP

Slot
1
2
X2
3

PROFIBUS (1): DP master system

Module
Periphery slave
...
...
...

Slot
1
2
3
...

DP-Slave...

CPU 214

PW

SF

FC

M C

R

S

RN

ST

M R

MM C

2

PB-
Addr.:3 ... 125

...

 
 

• Transfer your project to the CPU 21x-2BM06. 

Configuration of 
the master system 

Configuration of the 
DP slaves 

Transfer the project  
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PROFIBUS installation guidelines 
 

• A PROFIBUS DP network may only be built up in linear structure. 
• PROFIBUS DP consists of minimum one segment with at least one 

master and one slave. 
• A master has always been deployed together with a CPU. 
• PROFIBUS supports max. 126 participants. 
• Per segment a max. of 32 participants is permitted. 
• The max. segment length depends on the baud rate:  

9.6 ... 187.5kbaud → 1000m 
500kbaud  → 400m 
1.5Mbaud  → 200m 
3 ... 12Mbaud  → 100m 

• Max. 10 segments may be built up. The segments are connected via 
repeaters. Every repeater counts for one participant. 

• The bus respectively a segment is to be terminated at both ends. 
• All participants are communicating with the same baud rate. The slaves 

adjust themselves automatically on the baud rate. 
 

As transfer medium PROFIBUS uses an isolated twisted-pair cable based 
upon the RS485 interface.  
The RS485 interface is working with voltage differences. Though it is less 
irritable from influences than a voltage or a current interface. You are able 
to configure the network as well linear as in a tree structure.  
Max. 32 participants per segment are permitted. Within a segment the 
members are linear connected. The segments are connected via repeaters. 
The maximum segment length depends on the transfer rate. 
PROFIBUS DP uses a transfer rate between 9.6kbaud and 12Mbaud, the 
slaves are following automatically. All participants are communicating with 
the same transfer rate.  
The bus structure under RS485 allows an easy connection res. 
disconnection of stations as well as starting the system step by step. Later 
expansions don’t have any influence on stations that are already integrated. 
The system realizes automatically if one partner had a fail down or is new 
in the network. 
 

PROFIBUS in 
general 

Transfer medium 
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The following picture illustrates the terminating resistors of the respective 
start and end station. 
 

RxD/TxD-P(B)

Shield

Master Slave

3

8

3

8

P5V P5V

M5V M5V

330 330

330 330

220 220

3

8RxD/TxD-N(A)

5

6

RxD/TxD-P(B)

RxD/TxD-N(A)

Slave

RxD/TxD-P(B)

RxD/TxD-N(A)

5

3

8

6

Shield Shield

 
 

Note! 
The PROFIBUS line has to be terminated with its ripple resistor. Please 
make sure to terminate the last participants on the bus at both ends by 
activating the terminating resistor. 
 

 
 

In PROFIBUS all participants are wired parallel. For that purpose, the bus 
cable must be feed-through. 
Via the order number VIPA 972-0DP10 you may order the bus connector 
"EasyConn". This is a bus connector with switchable terminating resistor 
and integrated bus diagnostic. 

C

A

B

90°

A

B

0°

B

A

45°

 
 

 0° 45° 90° 
A 64 61 66 
B 34 53 40 
C 15.8 15.8 15.8 

        in mm 

Bus connection 

     

EasyConn  
bus connector 
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Note! 
To connect this EasyConn plug, please use the standard PROFIBUS cable 
type A  (EN50170). Starting with release 5 you also can use highly flexible 
bus cable: Lapp Kabel order no.: 2170222, 2170822, 2170322. 
With the order no. 905-6AA00 VIPA offers the "EasyStrip" de-isolating tool 
that makes the connection of the EasyConn much easier.  
 

11 6

       
Dimensions in mm  
 
 
The "EasyConn" bus connector is provided with a switch that is used to 
activate a terminating resistor. 
 
 

1./last 
bus participant 

 
 

further 
participants 

 

Attention! 
The terminating resistor is only effec-
tive, if the connector is installed at a bus 
participant and the bus participant is 
connected to a power supply. 
 
Note! 
A complete description of installation 
and deployment of the terminating 
resistors is delivered with the connector.

 

 
 

• Loosen the screw. 
• Lift contact-cover. 
• Insert both wires into the ducts 

provided (watch for the correct  
line color as below!) 

• Please take care not to cause a  
short circuit between screen and  
data lines! 

• Close the contact cover. 
• Tighten screw  

(max. tightening torque 4Nm). 
 
The green line must be connected to A, the red line to B! 
 

 

     

Termination with 
"EasyConn" 

Wiring 

Assembly 

Please note: 
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Commissioning and Start-up behavior 
 

In delivery the CPU is overall reset. The PROFIBUS part is deactivated and 
its LEDs are off after Power ON. 
 

The DP master can be served with bus parameters by means of a 
hardware configuration. As soon as these are transferred the DP master 
goes online with his bus parameter. This is shown by the RUN LED. Now 
the DP master can be contacted via PROFIBUS by means of his 
PROFIBUS address. In this state the CPU can be accessed via PROFIBUS 
to get configuration and DP slave project. 
 

If the master has received valid configuration data, he switches to Data 
Exchange with the DP Slaves. This is indicated by the DE-LED. 
 

After PowerON respectively a receipt of a new hardware configuration the 
configuration data and bus parameter were transferred to the DP master. 
Dependent on the CPU state the following behavior is shown by the DP 
master: 
 
• The global control command "Clear" is sent to the slaves by the master. 

Here the DE-LED is blinking. 
• DP slaves with fail safe mode were provided with output telegram length 

"0". 
• DP slaves without fail safe mode were provided with the whole output 

telegram but with output data = 0. 
• The input data of the DP slaves were further cyclically transferred to the 

input area of the CPU. 
 
• The global control command "Operate" is sent to the slaves by the 

master. Here the DE-LED is on. 
• Every connected DP slave is cyclically attended with an output telegram 

containing recent output data. 
• The input data of the DP slaves were cyclically transferred to the input 

area of the CPU. 
 

 
 
  

Start-up on 
delivery 

Online with bus 
parameter without 
slave project 

Slave 
configuration 

CPU state controls 
DP master 

Master behavior at 
CPU STOP 

Master behavior at 
CPU RUN 
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Chapter 5  Configuration with TIA Portal 
 

In this chapter the project engineering of the VIPA CPU in the Siemens TIA 
Portal is shown. The chapter only describes the basic usage of the 
Siemens TIA Portal together with a VIPA CPU.  
More detailed information about the Siemens TIA Portal is to be found in 
the according online manual respectively documentation. 
 

 

Theme     Seite 
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TIA Portal - Limitations  
 

Since the VIPA-CPU is configured as CPU 315-2AG10 in the Siemens TIA 
Portal, there are limitations with the configuration of the VIPA-CPU, which 
are in the following described. 
 

The VIPA specific SFCs are not supported during programming with the 
Siemens TIA Portal. 
 

• OB 55 "Status interrupt" is not supported by the VIPA-CPU 
• OB 56 "Update interrupt" is not supported by the VIPA-CPU 
• OB 81 "Error in power supply" exists in the VIPA-CPU but is not 

supported by the Siemens TIA Portal 
• The phase shift, available for the OB 35 "Watchdog" in the Siemens TIA 

Portal, is not evaluated by the VIPA-CPU. 
 

• "Plant designation" and "location identifier" in the Siemens TIA Portal are 
not supported by the VIPA-CPU. 

• In contrast to the Siemens CPU 315-2AG10 with a periphery address 
area 0 to 2047, the periphery address area of the VIPA-CPU is limited to 
0 to 1023. The diagnostic address area is 0 to 2047 and is not limited. 

• The bit memory (retentive memory) area is limited to 0 to 1023. 

General 

VIPA specific 
SFCs 

Operating  
blocks - OBs 

Further limitations 
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TIA Portal - Work environment  
 

TIA is the abbreviation for Totally integrated Automation from Siemens. 
Here your VIPA PLCs may be configured and linked. For diagnostics online 
tools are available. 
 

Note! 
Information about the Siemens TIA Portal may be found in the online help 
respectively in the according online documentation. 
 

To start the Siemens TIA Portals with Windows select Start > Programs > 
Siemens Automation > TIA ...  
Then the TIA Portal opens with the last settings used. 
 

TIA

Open existing project

Create new project

...

Start

Online &
Diagnostics

Existing Projects:

Project 1
Project 2
Project 3
...

> Project view  
 

With the menu Project > Exit in the Project view you may exit the TIA 
Portal. 
Here there is the possibility to save changes of your project before. 
 

General 

     

Starting the  
TIA Portal 

Exiting the  
TIA Portal 
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Basically, the TIA Portal has the following 2 views. With the button on the 
left below you can switch between these views: 
 

The Portal view provides a "task oriented" view of the tools for processing 
your project. Here you have direct access to the tools for a task. If 
necessary, a change to the Project view takes place automatically for the 
selected task. 
 
The Project view is a "structured" view to all constituent parts of your 
project.  
 
The Project view is divided into the following areas: 
 

TIA

Menu ...

2

3

5

6

8

4

7
1

 
 
 

[1] Menu bar with toolbars  
[2] Project tree with Details view 
[3] Project area 
[4] Device overview of the project respectively area for block 

programming 
[5] Properties dialog of a device (Parameter) respectively  area for 

information 
[6] Hardware catalog and tools 
[7] "Task-Cards" to select hardware catalog, tasks and libraries 
[8] Jump to Portal or Project view 

 
 
 

Work environment 
of the TIA Portal 

Portal view 

Project view 

Areas of the  
Project view 
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TIA Portal - Hardware Configuration - CPU  
 

The hardware configuration of the CPU and the system 200V modules at 
the VIPA bus takes place in the Siemens TIA Portal as a virtual PROFIBUS 
systems.  
For the PROFIBUS interface is standardized software sided, the 
functionality is guaranteed by including a GSD-file into the Siemens TIA 
Portal. 
Your project can be transferred to the CPU via MPI interface or by means 
of a MMC. 
 

The GSD files may be found at www.vipa.com at the "Service" part. 
 
The integration of the vipa_21x.GSD takes place with the following 
proceeding: 
• Browse to www.vipa.com. 
• Click to Service > Download > PROFIBUS GSD files. 
• Download the file System_100V_-_200V_Vxxx.zip starting with V 2.2.2. 
• Extract the file to your work directory. The vipa_21x.gsd (german) 

respectively vipa_21x.gse (english) is stored in the directory CPU21x. 
• Start the Siemens TIA Portal. 
• Close every project. 
• Switch to the Project view. 
• Select Options > Install general station description file (GSD). 
• Navigate to the directory CPU21x, select the according vipa_21x.gsd 

(german) or vipa_21x.gse (english) and click at [Install]. 
The hardware catalog is refreshed and the Siemens TIA Portal is finished. 
After restarting the Siemens TIA Portal all the System 200V CPUs and 
modules of the System 200V from VIPA can now be found in the hardware 
catalog at: 
Other field devices > PROFIBUS DP > I/O > VIPA GmbH > 
VIPA_System_200V. 
 

Note! 
Thus, the VIPA components can be displayed, you have to deactivate the 
"Filter" of the hardware catalog. 

General 

Integration of the 
GSD file 
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To be compatible with the Siemens TIA Portal the VIPA CPU is to be 
configured as CPU 315-2DP (6ES7 315-2AG10-0AB0 V2.6) from Siemens. 
The evolvement of the CPU 21x takes place as a virtual PROFIBUS master 
system with the following proceeding: 
 
• Start the Siemens TIA Portal. 
• Create a new project in the Portal view with Create new project. 
• Change to the Project view. 
• Click in the Project tree at Add new device. 
• Select the following CPU in the input dialog: 

SIMATIC S7-300 > CPU 315-2DP > 6ES7 315-2AG10-0AB0 V2.6.  
Then the CPU is inserted with a profile rail. 

 
Project area: 

1 2 4 5 6 7

 
 
Device overview: 
Module ... Slot ... Type ... 
PLC...  2  CPU 315-2DP  
 MPI interface...  2 0  MPI interface..  
 DP interface...  2 X2  DP interface...  
      
...      
 

Since the CPU from VIPA is configured as Siemens CPU, so the 
parameterization takes place via the Siemens CPU. 
For parameterization click in the Project area respectively in the Device 
overview at the CPU part. Then the parameters of the CPU part are shown 
in the Properties dialog. Here you can make your parameter settings. 
 
Note! 
The parameters are described in chapter "Deployment CPU..." at "CPU 
parameterization". 

Proceeding 

Parameterization 
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• Connect and parameterize the internal DP interface at operation mode 
"DP-Master". 

 

 

Note! 
Thus, the VIPA components can be displayed, you have to deactivate the 
"Filter" of the hardware catalog. 
 

 

• Switch in the Project area to "Network view". 
• Connect the slave system "VIPA_CPU 21x". After installing the 

vipa_21x.GSD this may be found in the hardware catalog at: 
Other field devices > PROFIBUS DP > I/O > VIPA GmbH > 
VIPA_System_200V > VIPA_CPU21x. 

• For the slave system CPU21x-Slave-System set the PROFIBUS 
address 1. 

T I A

M e n u  . . .

Catalog

FilterPLC
CPU 315-2DP

Slave
VIPA_CPU21x

CPU 21x

PROFIBUS

1
Other field devices
  PROFIBUS DP
    ... 
    I/O
      VIPA GmbH
        VIPA_System_200V
          VIPA CPU21x
              VIPA CPU21x
              Universal module
              ...

2

Network view

General
PROFIBUS- address
General DP param...
...

PROFIBUS address

interface networked with

Subnet: PROFIBUS...

Parameters

Address: 1

PropertiesSlave

3

 
 

• Click at the slave system and open the "Device overview" in the Project 
area. 

• Configure at slot 1 the according CPU 21x-2BM06 of the hardware 
catalog of the VIPA_System_200V.  

 
Device overview: 
Module ... Slot ... Type ... 
Slave...  0  VIPA CPU21x  
21x-2BM06  1  21x-2BM06...  
  2    
 
 

Configure a 
PROFIBUS master 
system 

     

Connect 
VIPA_CPU21x 
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• Install the corresponding GSD file of your slave system in the hardware 
configurator. 

• Search the corresponding PROFIBUS DP slave in the hardware catalog 
and drag&drop it to the subnet of your master. 

• Assign a valid PROFIBUS address > 2 to the DP slave. 
• Add your modules according to the real hardware assembly.  

 

T I A

M e n u  . . .

PLC
CPU 315-2DP

Slave_1
VIPA_CPU21x
PB-Addr: 1

CPU 21x

PROFIBUS

Network view

Slave_2
Slave system
PB-Addr: 3 ... 125

CPU 21x

 

Configuration of the 
DP slaves 
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TIA Portal - Hardware configuration - I/O modules 
 

After the hardware configuration of the CPU place the System 200 modules 
at the bus in the plugged sequence.  
For this drag&drop the according module from the Hardware catalog to the 
according position in the Device overview.   
 

Slot
0
1
2
3
4
5
6
7
...

D
I 8

xD
C

24
V

D
O

 8
xD

C
24

V

D
IO

 8
xD

C
24

V

AI
 4

x1
2B

it

AO
 4

x1
2B

it

CPU 21x

PB-
Addr.:1

PB-
Addr.:2

PLC
CPU 315-2DP

Slave
VIPA_CPU21x

CPU 21x

PROFIBUS

Modul
Slave
CPU
DI
DO
DIO
AI
AO

Parameter DIO

Param : .........
Param : .........
Param : .........
Param : .........

Param : .........
Param : .........
Param : .........
Param : .........

 
 

To provide specific addressing of the installed peripheral modules, certain 
addresses must be allocated in the CPU. 
For parameterization click in the Device overview on the module you want 
to parameterize. The parameters of the module appear in the Properties 
dialog.  
Here you can make your parameter settings. 
 
 
 
 

Hardware 
configuration of 
the modules  

Parameterization  
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TIA Portal - Project transfer 
 

There are the following possibilities for project transfer into the CPU: 
• Transfer via MPI 
• Transfer via MMC 
 

 

Currently the VIPA programming cables for transfer via MPI are not 
supported. This is only possible with the programming cable from Siemens.  
• Establish a connection to the CPU with an appropriate programming 

cable. Information may be found in the corresponding documentation of 
the programming cable. 

• Switch-ON the power supply of your CPU and start the Siemens TIA 
Portal with your project. 

• Select in the "Project tree" your CPU and choose from the context menu 
Download to device > Hardware configuration to transfer the hardware 
configuration. To transfer your PLC program choose Download to device 
> Software. Due to the system you have to transfer hardware 
configuration and PLC program separately. 

 

 

The MMC (Memory Card) serves as external transfer and storage medium. 
There may be stored several projects and sub-directories on a MMC 
storage module. Please regard that your current project is stored in the root 
directory and has one of the following file names: 
• S7PROG.WLD 
• S7PROGF.WLD  
• AUTOLOAD.WLD 
With Project > Memory card file > New a WLD file may be created in the 
Siemens TIA Portal. Then the wld file is shown in the project tree at 
"SIMATIC Card Reader" as "Memory card file". 
Copy the blocks from the Programm blocks to the wld file. Here the 
hardware configuration data are automatically copied to the wld file as 
"System data". 
 

Overview 

Transfer via MPI 

Transfer via 
MMC 
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The transfer of the application program from the MMC into the CPU takes 
place depending on the file name after an overall reset or PowerON. 
• S7PROG.WLD is read from the MMC after overall reset and transferred 

into the battery buffered RAM. 
• S7PROGF.WLD is read from the MMC after overall reset and 

transferred into the battery buffered RAM and additionally into the Flash 
memory. An access to the Flash memory only takes place at empty 
battery of the buffer and when no MMC with user program is plugged-in. 

• AUTOLOAD.WLD is read after PowerON from the MMC and transferred 
into the battery-buffered RAM . 

The blinking of the LED "MC" of the CPU marks the active transfer. Please 
regard that your user memory serves for enough space, otherwise your 
user program is not completely loaded and the SF LED gets on.   
 

When the MMC has been installed, the write command stores the content 
of the battery buffered RAM as S7PROG.WLD on the MMC and in the 
internal Flash memory.  
The write command is to be found in the Siemens TIA Portal in the Task 
card "Online tools" in the command area at "Memory" as button [Copy RAM 
to ROM]. Only if this function is supported by the CPU, this button is shown. 
During the write process the "MC"-LED of the CPU is blinking. When the 
LED expires the write process is finished. 
If this project is to be loaded automatically from the MMC with PowerON, 
you have to rename this on the MMC to AUTOLOAD.WLD. 
 
After a MMC access, an ID is written into the diagnostic buffer of the CPU. 
To monitor the diagnosis entries, you select Online & Diagnostics in the 
Siemens TIA Portal. Via the register "Diagnostic Buffer" you reach the 
diagnosis window.  
Information about the Event-IDs can be found at "VIPA specific diagnostic 
entries". 
 
 

Transfer  
MMC →→→→ CPU 

Transfer  
CPU →→→→ MMC 

Transfer control 
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